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Doc-To-Help Quick Tour

This mini self-paced tutorial will show you how easy it is to create a project in Doc-To-Help, as well as build your

output, apply styles, create links, and more. You will build a project about Pittsburgh using two existing documents. This

Quick Tour uses Microsoft® Word as the document editor, but the same principles apply when you are using Doc-To-

Help's built-in Content Editor or an HTML editor.

The Doc-To-Help in 5 Lunches Tutorial Series is another quick start resource you should check out. It has Word and

Built-In Editor versions, plus accompanying videos. See Learn How Doc-To-Help Works in Five Lunch Breaks.

As you are working through this Quick Tour, you may want to =I_earn more about the features discussed — if so, please
refer to the Dynamic Help window, or click the Help button " to open Doc-To-Help online Help.

[:a Watch the video: Starting a New Project in Doc-To-Help (3:48)

DmE @9 -+ ComponentOne Doc-To-Help - AllAboutPittsburghHTML.d2h (=B
m Home Editor Insert Table Topics Project _D'@'

2 éCJ 39 Publish = @Targe’(Template' Ij New = [0 Platforms: - a’%

k) @ = . ) = Y @ @ Source Template ~ [ &) %
Select | Build Rebuild View el = aenss Lesed UTERE B Frrrn T o Share Synchronize Translate Work
Target - - - & Build Log mThEmE i xj Remove E Attributes: o Offline

Target - All About Pittsburgh Responsive MetH... = Target Design Source - Documents\All About Pittsburgh.xml Fl SharePoint® Documents

Dynamic Help

© ‘;&Search E‘Indax

Documents ﬁ} Start Page /Vj Topics)/ej All About Pittsburghxml >
.tl :| ﬂ' _; = X | B & B <body> -H <hl> |

-4 All About Pittsburgh.xml

H-Px Pittsburgh Sports.xml H

%j Pittsburgh Meighborhoods.xml AII AbOUt PIttSburgh

oj Pittsburgh Sitesxml . . . L
°j Cultural District.xml Pittsburgh is a great place to live, work, and visit. "All About

= . Pittsburgh” is a resource that will help you learn more about
°j Famous Pittsburghers.xml . e ki i sports te 5

&7 Pittsburgh's history, neighborhoods, sports teams, colleges and
784 Pittsburgh Amusement Parks xml universities, popular attractions, and more.

% Pittsburgh Colleges and Universities.xml X X L .

& D - Pittsburgh is the second-largest city in Pennsylvania and was once
| j Pittsburgh Cuisinesxml " P . .

83 Tourist Information Centersaxml known as "The Steel City." However, manufacturing is no longer at
'""o" " the heart of Pittsburgh's economy. Pittsburgh is now a high-tech
J’i Referencesxml center focused on the health care, education, technology, and
~485 Glossaryml financial services industries. Pittsburgh is also known for its
= successful and popular sports teams.

1/ ] Documents The city of Pittsburgh, Pennsylvania recently celebrated its 250th
1] — anniversary(its semiguincentennial!). The center of Pittsburgh is the
B often-photographed confiuence — the spot where the Monongahela
Lfl Index and Groups ‘:lnrl Allanhany rivars mnnr”fr'n farm tha Ohin | :

»

Welcome to
Doc-To-Help!

Doc-To-Helpis a

single source authoring tool
that makes it possible to
write once and publish many
different deliverables.
Technical communicators,
Help authors, policy writers,
and other content creators
can author any type of
information in Microsoft Word,
or the built-in HTMLS content
editor and publish to the
Web, Help systems, EPUB, or

m

ﬁg Related Topics (4 Design | ¥ Design with D2ZHML markers [ Source 4 Preview

printed manuals. It is the

| > b

m
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http://our.doctohelp.com/2012/05/14/learn-how-doc-to-help-works-in-five-lunch-breaks/
http://www.youtube.com/watch?v=18TtXI7LYes

Let's get started ...
Creating a new project is quick and easy with the Getting Started Wizard.

This wizard opens when you open Doc-To-Help. It can also be used to open an existing project, open a sample project (a
great way to test drive a Word or HTMLS5 project), or convert an older existing project to a Doc-To-Help Project.

e ™

. Getting Started With Doc-To-Help

What Would You Like to Do?

= o

Once you have created or opened a Doc-To-Help project, you can produce as many Help, Print, and Web
7, o0, L " hel A o c =)
target outputs as you need. Pick an option below to get started

() a Start a New Project
Create a brand new project. You can have Doc-To-Help create new files, or you
can import your own Word, HTML, or XHTML files.

® # Open an Existing Project
P

Browse projects you have already created.

Open a Sample Project

i Open one of our pre-assembled projects.

) Convert an Existing Help Project to a Doc-To-Help Project
‘ Convert a RobeHelp, HTML Help, WinHelp, or Doc-To-Help 2000 project.

Resources

38 ComponentOne Video Library &) Guided Tour #e Free Introductony Webcasts

'@ Help . Doc-To-Help Web Site ::, Training Information

|| Show this wizard at startup [ Next > ] [ Cancel

Choose Start a New Project and click Next.

Note: If you have closed the Wizard, click the Getting Started Wizard button in the upper right to reopen it.

Home Topics Project @

é} 3 é o @JTargetTemplate' ﬂ New ~ [ Platforms: N 4& o [
=5 @ " ) Cancel Build - y @ @ Source Template ™ i Q 0 % |
Select | Build Rebuild View 2 Build Log EslEmet CS LsAdd Targets: 2.3 Source CS5 * Share Synchronize Translate Worlk
Target ~ - - Theme " xj Remove E Attributes: ~ Offline
Target - Pittsburgh 250 HTML Help ] Target Design Source - Documents\Pittsburgh250References.doc Fl SharePoint® Documents

2 e Doc-To-Help Quick Tour Getting Started Workbook



I )

_ New Project Wizard ==
Name Your Project

Project Mame

Mew Project

Location

ChUsers\nickyb Documents\My Doc-To-Help Projects'Mew Project

Doc-To-Help will create a project directory for you. To specify a different one, click the Browse button.

Avoid locations that already contain a Doc-Te-Help project file (.d2h).

< Back | [ Mext = l | Cancel

Getting Started Workbook Doc-To-Help Quick Tour e 3



Name your project Pittsburgh. Doc-To-Help will automatically name the project location folder with the same name.

Note that Doc-To-Help saves your project in the default My Doc-To-Help Projects folder. This makes it easy to keep
your projects organized.

(You can change the default folder if you wish, just click the File tab > Doc-To-Help Options button. Choose the Files
button.)

I )

. Mew Project Wizard @
Name Your Project

Project Mame

Pittsburgh

Location

C:\Users\nickyb\Documents{My Doc-To-Help Projects\Pittsburgh

Doc-To-Help will create a project directory for you. To specify a different one, click the Browse button.

Avoid locations that already contain a Doc-Te-Help project file (.d2h).

< Back | [ Mext = l | Cancel

Click Next.
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The next screen will give you the opportunity to import settings from an existing project. Since we are going to work

through a few settings later, we will skip this screen.

e

- Mew Project Wizard

Import Settings From an Existing Project

check box below and choose the project file using the Browse button.,

Import settings from this project:

If you would like to import settings (styles, output settings, variables, etc.) frorm another project, select the

-

==

< Back | [

Mext > l | Cancel

Click Next.

Getting Started Workbook
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Now, you can select the default language for your project. By default, it is U.S. English, but you can choose another

from the drop-down.

Doc-To-Help will choose the correct character set based on the language chosen.

i

- Mew Project Wizard

Select the Default Language

easily readable,

Select the main (default) character set you'd like to use for this project. You will be able to use other
characters too, but selecting the appropriate main language can make your files smaller in size and more

-

==

English {United States)

< Back | [ Mext = l | Cancel

Click Next.
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Doc-To-Help uses templates and style sheets to determine how content will look and behave in both your Source
documents (when authoring in Word, Doc-To-Help's built-in Content editor, or an HTML editor) and your final Targets
— the online Help and printed manual outputs.

Now you can use the wizard to select the style sheet (.css) for your HTML5 or HTML Source documents and the
template (.dot) file for your Microsoft® Word Source documents.

Doc-To-Help will automatically choose your Target style sheet and template based on your selections.
e  Leave the default setting of Full set of styles.

e Leave the default setting of Normal 8-1/2" x 11" Template (no left indent).

- Mew Project Wizard @

Select the Default Source Style Sets

Doc-To-Help automatically attaches a Microsoft® Word template or a style sheet to your project's
docurnents. You can change them later or use your own.

Select style sheet type:

£33
@ Full set of styles -

This style sheet will be used for your HTML and XHTML documents.

Select document ternplate:

m= Mormal 85" x11" Temnplate (no left indent) -

This template will be used for your Microsoft® Word documnents.

Learn more about styles

< Back | [ Mext = l | Cancel

Click Next.
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Now, select your default Help target. You can generate any of these targets from your project at any time, but the default
chosen here will be the one displayed when you open your project. Choose NetHelp (Doc-To-Help's browser-based
uncompiled HTML format). This output can be used on the web, within a software application, or on a file server.

-

N
. New Project Wizard [

Select the Default Target

A Target is a Doc-To-Help output. Choose the default Target for your project below.

You can select and build any Target once your project is created; your default choice is effective only until
you choose another,

@

2 HTML Help 1.x
&JavaHelp
%Microsoﬂ Help 2.0
'@'Microsof‘t Help Viewer
:2| Printed Manual

& WinHelp 4.0

= Eclipse Help

& EPUB

Learn more about targets

< Back | [ Mesxt = ] | Cancel

N

Click Next.
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Now you select the type of document you'd like your first document to be. Choose Import existing files — because we
are going to use an existing document to start our project.

Doc-To-Help will launch another Wizard after the project is created that makes it easy to import an existing document.

L New Project Wizard 2 |

How Would You Like to Start Creating Content?

Choose how you would like to start, and Doc-To-Help will create initial files in the format of your choice,
import existing files, or leave the project empty.

(") Doc-To-Help's HTMLS editor
Project will include a new HTMLS topic for use in Doc-To-Help's editor.

") External HTML editor (e.g.. Adobe Dreamweaver)

Project will include a new HTML topic for use in an external editor,

() Microsoft Word

Project will include a new Microsoft Word document.

@ Import existing files
An import wizard will appear after the project is created. You will be able to select Word or HTML
files on your computer, on the network, or in a SharePeoint docurnent library.

(7 Start with an empty project

Mo initial docurnents will be created, You can then create documents in any format.

< Back | [ Mesxt = l | Cancel

L -

Click Next.

Getting Started Workbook Doc-To-Help Quick Tour e 9



That's it! Review the new project information and click Finish.

s "

_ New Project Wizard ==

Confirm Settings and Create Project

Project File Name: ChUsers\nickyb\Documents\My Doc-To-Help Projects\Pittsburgh®Pit...
Source Style Sheet: Full set of styles

Source Document Termnplate: Mormal 85" 211" Template (no left indent)

Default Help Target: MetHelp

Initial Document Type: Imported documents

Werify the settings abowe, then click Finish to create your new project. If you have selected the "Import
existing files" option, an import wizard will appear after you click Finish,

< Back | [ Finish l | Cancel

10 e Doc-To-Help Quick Tour Getting Started Workbook



Our project is created, but since we chose the Import existing files option, the Document Import Wizard will open.

s "

- Document Import Wizard @

Choose Document Location

ﬂ @ Local

-
Import documents stored on your computer or the network,

SharePoint®
Import documents stored in a SharePoint Library.

Mext = l | Cancel

Choose Local and click Next.

Getting Started Workbook Doc-To-Help Quick Tour e 11



| Document Import Wizard

Choose the Type of Document to Import

8
@ Microsoft® Word (.doc or .docx)
@
(70 HTML (.htm or .html)
HTML

9 (7 HTMLS (xmnl)
X

= Back | [

Mext =

/|

Cancel

L

Choose Microsoft® Word and click Next.

12 e Doc-To-Help Quick Tour
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.| Document Import Wizard @

Choose an Import Option

Doc-To-Help allows you to work in Microsoft® Word or convert the file(s) to HTMLS for editing in the
built-in editor.

@ Keep my content in Word

Your files will be added to the project and you can continue working in Word.

() Convert to HTMLS

Doc-To Help will convert your Word file(s) to HTMLS so that you can work with them in
Doc-To-Help's editor.

= Back | [ Mext = l | Cancel

L -

Choose Keep my content in Word and click Next.

Getting Started Workbook Doc-To-Help Quick Tour e 13



Now click the Add file(s) button to select the file. The file you need is named PittsburghQuickTour.doc.

The Select Files for Import dialog box will automatically open to the My Doc-To-Help Projects folder.
PittsburghQuickTour.doc can be found in \Samples\All About Pittsburgh Sample Word\Documents.

. Document Import Wizard

|1

Select Files or Folders to Import

Doc-To-Help will import all files and folders added below.

@ Copy files tof

) Leave files af

"—W
re Resources

What's Mew in Dog|
Doc-To-Help At-A-
Doc-To-Help Comi
Doc-To-Help Propeg
Doc-To-Help User
Doc-To-Help 2013

L

b

nents

&)
jate  Work
Offline

Add file(s)...

1 Select files for impart = |
@uv| = All About Pittsburgh Sample Word » Documents - | 5 | | Search Documents pe |
Organize = MNew folder =y 0 @

1% Computer i Name Date modified Type é

4. Downloads

= Recent Places
- Libraries

@ Documents

J‘i Music

[ Pictures

B videos

18 Computer
& os ()

] About This Sample_Read Me First.doc
B All About Pittsburgh References.doc
B All About Pittsburgh.doc

] Glossary.doc

] pittshburghQuickTour.doc I

W1 PittsburghRichContentVariables.doc

m

10/30/2013 9:34 AM
10,/30/2013 9:34 AM
10/30/2013 9:34 AM
10/30/2013 9:34 AM
10/30/2013 9:34 AM
10/30/2013 9:24 AM

'-—4| 1

File name: PittsburghQuickTour.doc

Microsoft V
Microsoft V

Microsoft V

Microsoft V AI
Microsoft V

Microsoft V At

ERmE

- ’Word documents (*.doc;*.docy VI

[ Open

I |

Cancel ]

Click the Open button in the Select files for import dialog box. PittsburghQuickTour.doc will display in the Wizard.
Please note that Doc-To-Help will automatically copy this file into the appropriate folder; your project's Documents

folder.

14 e Doc-To-Help Quick Tour
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"~ "

w!' Document Import Wizard @
Select Files or Folders to Import
Doc-To-Help will import all files and folders added below.
----- JEI_] PittsburghQuickTour.doc

[ Add file(s)... ]

| Addfolder.. |
@ Copy files to: Documents E
() Leawve files at their original location

< Back | [ Import ] | Cancel

Click Import and the document will be imported.

Getting Started Workbook Doc-To-Help Quick Tour e 15



"~ "

w!' Document Import Wizard

g

Import completed

@ The documents have been successfully imported.

Close

Click Close. The imported document displays in the Documents pane. The Documents pane is "Home base" in Doc-
To-Help.

16 e Doc-To-Help Quick Tour Getting Started Workbook



DIhEE g o G- ComponentOne Doc-To-Help - Pittsburgh.d2h ‘

Home Topics Project
: 3 QJTargetTemplate' “j Mew = [ Platforms: T
ﬁ @ % é@l @ Cancel Build @J Source T

an . :
Select | Build Rebuild View 5 g iig (o G Target €55 [3Add @ Tergets S Source C
P g e . Cs3 Source
Target - - - Theme b zj Remove E Attributes: S
Target - NetHelp T Target Design Source - Documnents\PittsburghQuickTour.doc
Documents 7} StartPage | 3| Topics |
'ﬂ :'] cj' _;- @ = X |+ > ¢
BT ) PittsburghQuickTour.doc Welcome to DOC Help
Common Tasks
! G @
A P T P o PRy ‘_.-*-“‘*'d-\. r , - T .

As noted earlier, our document was automatically added to the appropriate folder in the Doc-To-Help Pittsburgh project
folder. Word source documents are stored in the Documents folder of the project.

4 | My Documents
4 | My Doc-To-Help Projects
4 | Pittsburgh
., C55Files
./ Documents
. Media

From the Documents pane, double-click on PittsburghQuickTour.doc to open it. In Microsoft® Word, take a look at
the Doc-To-Help ribbon (it will be a toolbar in pre-2007 versions of Word). With it, you can create links, add index
entries, and more. Doc-To-Help uses this information to create the final Targets.

Doc-To-Help

ﬁ g@ d l‘ 2‘ "3 Ni‘ = Q g2 IE = v ﬁ %j (% 8 Collapsible section =

4, Clear Formatting =

[®) Flash Movie & j 2]
[ABC| [ABC)

[ HTML Help Contral

.

Add Rename Delete 1 2 3 4 Body Link Inline Keyword Group Link Topic  Conditional Variable Margin  Image . Add Sort About
Text Text Tag Properties  Text A Apply Style ~ Note - Map Editor [ft] Cross-reference - Terms
Tapic Headings D2HMIL Styles £l Links Glossary Help

Now it’s time to learn more about specific Doc-To-Help features. Although the lessons below are divided up to make
them more manageable, it is recommended that you do them in order so that you can see the progression of your project.

Getting Started Workbook Doc-To-Help Quick Tour e 17



Building and Examining a Target

So far, we've done very little, but we've given Doc-To-Help enough to work with. If we build right now, we can take a
look at what Doc-To-Help will do out-of-the-box — but first, let’s take a quick look at our Word document. If it is not
already open, double-click on PittsburghQuickTour.doc to open it.

It is structured like this:

Heading 1 — All About Pittsburgh
Heading 1 — Pittsburgh Sports
Heading 2 — Football

Heading 2 — Baseball

Heading 2 — Hockey

Heading 1 — Pittsburgh Sites

Doc-To-Help will use this structure to create topics, the table of contents, and automatic links.

Close PittsburghQuickTour.doc and click the Build button in Doc-To-Help. The default NetHelp Target (chosen
earlier) will be built.

ﬁ Home Topics Project
i}- @ % éd &) Cancel Build

Select | Build |Rebuild View ¢ Build Log
Target ~ - o

Target - NetHelp

Doc-To-Help will prompt you to view the Target. Click Yes.

ComponentOne Doc-To-Help [3m]

@
l@' Would you like to view the help target that has just been built?

[] Don't show me this again Yes l I Mo

(Your browser’s security settings may block display of NetHelp. Click “Allow blocked content” to view your Target.)

18 e Doc-To-Help Quick Tour Getting Started Workbook



Take a look at the Target first (we built Responsive NetHelp, which adjusts for any device):

e The Table of Contents structure is based on the Heading styles (since "Football”, "Baseball", and "Hockey"
were Heading 2s under the Heading 1 of "Pittsburgh Sports", they were converted to subtopics).

e  Click on the "Pittsburgh Sports" topic in the Table of Contents. The Topic has three automatic subtopic links —
"Football", "Baseball", and "Hockey" — which were created by Doc-To-Help based on the document structure.
We'll learn later how to add custom subtopics, but these are created automatically.

(& Pittsburgh Sports | ‘

Pittsburgh Sports

Pittsburgh olo|a = v f|

Pittsburgh Sports

Football Pittsburgh is well-known for its professional sports teams, and has been hailed as the "City of Champions” because
two teams (the Pittsburgh Steelers and Pittsburgh Pirates) won their league’s world championships in the same year
(197%). The Pittsburgh Penguins have also won the Stanley Cup three times (1991, 1992, and 2008].

Baseball
More:
Hockey Football
Baseball
Hockey

Favorites

Now a quick look at Doc-To-Help:

e Click the Contents pane button. The Table of Contents is displayed. In this pane, you can rearrange the TOC
any way you want, and add/delete topics, but the automatically generated Table of Contents is logical, and can
be used as-is if you like. Note that the Table of Contents in the Contents pane looks exactly like the Table of
Contents in the NetHelp Target.

e Click the Topics window tab. Each Heading 1 and Heading 2 is a separate Topic in the project. This will make
it possible to create links between topics and more.

Contents 42} Start Page )/:zl Output)/jl Topics ]

L . & i @ =1 X @ Document Title Style

@ Al About Pittsburgh s

EILIJ-I Pittsburgh Sports &) Documents\Pitts.. Al About Pittsburgh Heading 1

. J Football @ Documents\Pitts..,  Pittsburgh Sports Heading 1

| Documents\Pitts... Football Heading 2

“-|@ Pittsburgh Sites &) Documents\Pitts.. Baseball Heading 2
] Documents\Pitts... Hockey Heading 2
8| Documents\Pitts...  Pittsburgh Sites Heading 1

__j Documents

L Contents

Now that we've seen our baseline, let's add more to this project.

Getting Started Workbook Doc-To-Help Quick Tour e 19



Inserting a Graphic

First, the graphic we need must be moved into our project. Using Windows Explorer, navigate to WMy Doc-To-Help
Projects\Samples\All About Pittsburgh Word\Media. Copy Pittsburgh_Confluence.jpg. Drop it into the \My Doc-To-
Help Projects\Pittsburgh\Media folder. (Although you can use images from any folder, it is a good best practice to store

all of your images in your project's Media folder.)
Just a reminder, the My Doc-To-Help Projects folder can be found here:
e  Windows® 7/8 and Vista: \\Users\<username>\Documents\My Doc-To-Help Projects
o Windows XP: \\Documents and Settings\<username>\My Documents\My Doc-To-Help Projects

@Uv| b Libraries » Docurments | by Docurments » My Doc-To-Help Projects » Pittsburgh » Media

File Edit View Tools Help

Organize = Share with = Burn Mew folder

Documents library
- Libraries Media
3 Docurents
°| My Docurments
kly Doc-To-Help Projects

m

Mame

|7} Pittsburgh_Confluencejpg

Now we are ready to insert our graphic. If it is not already open, double-click on PittsburghQuickTour.doc in the
Documents pane to open it.

Add a new line after the third paragraph (it begins with “The city of Pittsburgh...”). In the Insert ribbon, click the
Picture button to open the Insert Picture dialog box. Choose Pittsburgh_Confluence.jpg and click the Insert drop-
down. Choose Insert and Link. This is the recommended option for Doc-To-Help projects.
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= B Al ol

Home Insert Page Layout
3| i+

Cover
Page

The graphic is now inserted in the document.

References

Mailings

PittsburghQuickTour.doc [Compatibility Mode] - Microsoft Word

Review

Developer Nuance PDF Doc-To-Help

hR=
,E‘
Blank Page

Page Break
Pages

Clip  Shapes SmartArt Chart
Art

Tables Tllustrations

-7

@_@vw <« Pittsburgh b Media

Organize »

New folder

Microsoft Word

* Favorites
B Desktop

1% Comy

Documents library
Media

Name

| 3

| @ Pittsburgh_Confluence,jpg

m. Downloads
"Zl Recent Places
‘3 Drophbox

Libraries
Documents
J" Music
[ Pictures
B videos

]

Arrange by:  Folder =

File name: Pittsburgh_Confluence.jpg

[ signature Lin
[53 Date & Time

Link to File

| Insertand Link |

Show previous versions

Getting Started Workbook
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- ™y
WE9- 06 PittsburghQuickTour.doc [Compatibility Mode] - Microsoft Word (o] B

“_Home Insert Page Layout References Mailings Review View Developer Muance PDF Doc-Ta-Help & e
[# cover Page - Ij ElE= LE'P % SmartArt %Hyperlink 5 Header - [Z Quick Parts ~ [ signature Line - JT Equation
|1 Blank Page ) n‘h Chart A& Bookmark é] Footer = ﬁWordAr‘t' EDate & Time £2 symbol =
= Table Picture Clip Shapes .. Text A " X
= Page Break - Art - #+ Screenshot I' Cross-reference [#] Page Number v | gy~ A5 Drop Cap~ ’gd Object ~

Pages Tables Ilustrations Links Header & Footer

All-About- Pittsburghf

Text Symbals

»

Pittsburgh-is-a-great-pla cetol]ive,- work,-andvisit.-“All- About-Pittsburgh-is-a resource-that will- help-youleam-more-
about Pittsburgh’'s-history, neighborhoods, sports-teams, volleges- and universities,-popularattractions, and more. -

Pittsburgh-is-the-second-largest-city-in-Pennsylvania and was-once known-as* The-Steel-City " However, manufacturing-
is-nolonger-atthe heartofPittsburgh’s- economy. Pittsburgh-is-now-a high-tech-center.-andis-now-focused onthe health-

care,education, technology, and financial services-industries - Pittsburgh-is-also known-forits successful-and popular-
sportsteams.

The-city-of Pittsburgh, - Pennsylvania recently-celebratedits-2 30thanniversary. The-center-o f Pittshurgh-is- the o ften-
photographedconfluence—the-spotwhere-the Monongahela and Allegheny rivers- meetto-formthe -Ohio .-

LRI |

Page: 1 of 3 | Words: 524 | Qﬁ | = | . |@E 3
\

100% (-———(+)
J

By the way, you can quickly add a Flash movie to your project using the Flash Movie button on the Doc-To-Help
ribbon tab.

%’ Doc-To-Help

! = - — iE Collapsible Section = _J= == | [E] Flash Mow

; +3 WE (= ¥ . @ s = =

i Clear Formatting _ @I—I‘I‘ML Help Control
37 Link Inline Keyword Group Link Topic  Conditional ‘u"arlable Margin  Image

{ Text Tag Properties Text -iﬁ Apply Style ~ Mote ~ Map Editor (] Cross-reference ~
i DZHML Styles ] Links
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Applying a Style

Doc-To-Help uses styles to markup your source documents. In Word, these styles are in stored in a template (.dot or
.dotx) file. The source styles are interpreted by the Target template to make the target files look and behave the way you
desire. For example, as you saw earlier, Heading 1 and Heading 2 styles will determine your project's topic list, the
structure of your Table of Contents and the automatic subtopic links.

In this section, you will learn how to apply a Doc-To-Help style in Word. Although the style we will apply in this
exercise is one that only controls formatting, later we will apply styles that control both formatting and behavior (see

Adding Glossary Entries on page 39).

If you were using Doc-To-Help's Content editor, you would apply styles using the Style List window, which is also very

easy to use.

When using Microsoft Word as your editor, you can apply styles quickly using the Home and Doc-To-Help ribbons.

™ e R BE PittsburghQuickTour.doc [Compatibility Mode] - Microsoft Word = [ B [t
Insert Page Layout References Mailings Review View Developer Muance POF IDoc-To-HeIp I & e
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All-About- Pittsburghf| Heading 1 -
. E Heading 2 1a
Heading 3 T
Heading 4 T
Heading 5 T
Pittsburgh-is-a-great-placetolive,-work,-andwvisit.-* All- About-Pittsburgh™-is-a resource-that
about Pittshurghs-history, neighborhoods, sports-teams, colleges- and universities, -popular- Heading 6 T
Pittsburgh-is-the-second-largest-city-in-Pennsylvania and was-once known-as“The-Steel- Cit .
is-nolonger-atthe-heartof Pittsburgh's- economy. Pittsburgh-is-now-a-high-tech-center,-and Heading Base T
care,education, technology. and financialservices-industries. - Fittsburgh-is-also known-for: T
sportsteams. Index Basze T
The-city-of Pittsburgh, - Pennsylvania recently-celebratedits-2 50th anniversary. The-center-c _ T
photographed confluence—the-spotwhere-the Monongahela and Allegheny nivers-meet tc
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- Show Preview
I [ Disable Linked Styles
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Let's add some new text to PittsburghQuickTour.doc. After “Pittsburgh has over 80 different neighborhoods,” add:
South Side (home of a mix of restaurants and live music venues)
Station Square (home of the Gateway Clipper)

Select the text and click the Styles dialog box launcher on the Home ribbon tab. The Styles box will open. (In Word
2003, from the Format menu, choose Styles and Formatting. The Styles and Formatting box will open.)

Choose the C1H Bullet style. The style is applied.

W9 o= PittsburghQuickTour.doc [Compatibility Made] - Microsoft Word =B s
Home Insert Page Layout References Mailings Review View Developer Muance PDF Doc-To-Help & 9
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B < omeow ETECT wicoz FAAL AaBhb
Paste . 2 w7 . A . N i i i ch Editing
aj e f B I U abe X, X é oy - ,% T Caption Headingl Heading2 - StyaI:sg'E -
Clipboard Font F] Paragraph F] Styles m
EE Styles v X
- s
C1 Section Collapsed T
C1 Section End 7=
E| C1 Section Expanded T
+ C1H Bullet T
Pittsburgh-hasover-80-different neighborhoods, meluding:7 » CIH Bullet2 T
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Open the Doc-To-Help ribbon tab, you’ll see that it includes the Heading 1, 2, 3, 4 and Body Text buttons so you can
apply those styles quickly.

} Doc-To-Help

i _

il [a H H H . () g — : »  tE Collapsible Section
| 2] 3] ['a| = I = W .?ﬁ = g

% - =b 24, Clear Formatting

i 1 2 3 4 Body Link Inline Keyword Group Link Topic  Conditional Wariable

4 Text Text Tag Properties Text A Apply Style -

i Headings D2ZHMIL Styles F

Creating a Topic Link

In PittsburghQuickTour.doc, go to the “North Shore” bullet and select the phrase "Pittsburgh Pirates" in the text, then
click the Link button on the Doc-To-Help ribbon. The Link dialog box will open.

@“ H9- 0|+ PittsburghQuickTour.doc [Compatibility Mode] - Microsoft Word = |8 23_]
“_ Home Insert Page Layout References Mailings Review View Developer Muance PDF Doc-To-Help [ o
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Take a quick look at the Link dialog box. Note that you can also create links to Keywords (AKA index entries),
Groups, Bookmarks, Link tags, and Glossary entries. Simply click on the Link type drop-down. Also note that in the
Options area, you can select the Show as Button check box. This will change your link text to a button. Selecting the
Popup check box in the Link options will make the topic display in a popup window. By the way, linking will work in
the PDF version of your manual target, as well as your Help targets.

Handy Hint: You can select a Grid or Tree view of the "link to" topics. Click the button to the right to choose.

o Link Lﬁ
Ted:
Link type: j Topic title - i
Target | | Topicin Document
Topic: |z] Topic title
¥ Linktag
Topics Bookmark in Document
Topic ¢ Keyword }
ks [ Group E
Baseball 1= Glossary term 1entsh\PittsburghQuickTour.doc

Now that you have learned more about the Link dialog box — in the Topics tab, expand PittsburghQuickTour.doc (if
necessary) and choose Baseball from the list. When you click OK, you will create a topic link from the phrase
"Pittsburgh Pirates™ to the topic about baseball.

If you have hidden text turned “on” in your document, you will see the information for this link tag displayed. As you
can see, the “tag” is the Topic you selected (“baseball”).

¢ = Oakland{thome ofthe University- of Pittsburgh-and Camegie hellon- University )7
s —+ NorthShore-(homeofthe Pittshurgh-

If you would like to hide hidden text — in Word 2007/2010/2013, choose the Office button (or File tab) > Word
Options, and click Display on the left. Clear the Hidden Text check box on the right. In Word 2003 and earlier, choose
Tools > Options. In the View tab, Formatting Marks section, clear the Hidden Text check box and click OK.
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Creating Inline Text

Inline text is expanding, drop-down, or popup text. It's a great way to add dynamic information to your Help project.

In PittsburghQuickTour.doc, select the phrase "250th Anniversary" from the first sentence and click the Inline Text
button. Choose the Expand text inline radio button, and add text (Its semiquincentennial!) in the text box.

@' = |+ PittsburghQuickTour.doc [Compatibility Mode] - Microsoft Word = & %
Home Insert Page Layout References Mailings Review View Developer Muance PDF Doc-To-Help & e
A k W H H " == i »  1E Collapsible Section
al e 12 3] [a] 5 Y & ® ¢Z
3l i -
£, Clear Formatting A
Add  Rename Delete 1 2 3 4 Body Link  Topic  Conditional Variable Links | Glossary| About
Text Tag Properties Text @A, Apply Style = e W
Topic Headings DZHML Styles Fl Help
i)
Pittsburgh is a great placeto live, work, andwisit. “All About Pittsburgh™ is a resource thatwill help vouleam more -
about Pittshurgh's history, neighborhoods, sports teams, colleges and universities, popular attractions, and more
Pittshurgh is the second-largest city in Pennsylvania and was once known as“The Steel City.” However, manufacturing
is no longer atthe heart of Pittsburgh’s economy. Pittsburgh is now a high-tech center, andis now focused onthe health
care, education, technology. and financial services ndustries. Pittsburgh is also known for its successful and popular
sports teams. L
The city of Pittsburgh, Pennsylvania racently celehratedn e center of Pittshurgh is the often-
photographed confluence —the spot where the Monongahela and Allegheny nvers meet to form the Ohio.
-
. Inline text
Selection:  250th anniversary Dynamic Help x
Ted Q@
Its semiqumcentenniall| - Using D2HML (Doc-To-Help Markup o
Language) =
Creating Inline,
Dropdown, or
- Popup Text
Options
= — The Inline text dialog box is
© Expand text inline used to create three different
() Dropdown text [C] Textin comment options for displaying additional
information.
() Show text in 2 popup
Where to find the Tnline Text ol
@ Closehel [ oK ] [ Cancel ]
d

Click OK. Doc-To-Help will inform you that this is an invisible style (this means the inline text we added will be

invisible in this document [our Source document]

as well as in our Target until clicked). Since that is OK, click No to

close the message box. When we build the Target, "250th Anniversary" will be a hyperlink that will display "lts
semiquincentennial!™ when clicked. Save and close the document, build, and take a look if you would like.
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Creating an Index Entry

You can add index keywords (also known as K-Links) right from your document. You can also do this in Doc-To-Help,

which will be demonstrated later.

Select the word "Monongahela” in PittsburghQuickTour.doc (it's in the 3" paragraph) and click the Keyword button

on the Doc-To-Help ribbon. Click OK to add “Monongahela” to your index.

“Monongahela” will display in your source document with a different text color, but that color change will not be visible
in your final Targets. It is there in your source so that you can see it.

|
™ G A Ik PittsburghQuickTour.doc [Compatibility Mode] - Microsoft Word =@ =
Home Insert Page Layout References Mailings Review View Developer Doc-To-Help [ e
§ = H H H n == ) - — b = Collapsible Section
AR RN A2F|l=vra ™ ¢ "
- =% 4% Clear Formatting —
Add  Rename Delete 1 2 3 4 Body Link Inline | Keyword |Group  Link Topic Links | Glossary| Apout
Text Text Tag  Properties A Apply Style ~ - -
Topic Headings D2HML Styles E} Help
spuits toatii. I?;_a
The-city-of Pittsburgh, - Pennsylvania recently-c 230thanniversary. The-center-of Pittsburgh-is- the often- e
photographed confluence —the-spotwhere thahMonongahelafand-Allegheny nvers- meet to-form the Ohio -7 .

L Keyword

Text: Monecngahela Dynamic Help x
[CUVLIC A (K eyword defined by Text) Q) ﬂ 2] ||
Keywords Using D2HML (Doc-Te-Help Markup il
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¢ Add New Keyword rng Add Secondary Keyword Il . o
Inserting an Index
Entry
You can assign and add keywords
Pittshurg (index entries or K-links) to your
documents using DZHML.
.
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. Visible Links to keywords are created
using the Link dialog box. Links 4
.
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\
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After you do a build, when you look in the Index and Groups pane of Doc-To-Help, Monongahela will be there.

Keywords
AR
il Monongahela

T —
Menongahela: One Topic Indexed

------ i All About Pittsburgh (PittsburghQuickTour.do

1| 1] [ »

__ﬁ Documents

___|_:]l Contents

ﬂ Index and Groups

52 Related Topics

You can add additional keyword and secondary keywords from this dialog box. See Adding Items to the Index and
Creating Groups on page 42.

Let's build our target now and take a look at it. First, save and close PittsburghQuickTour.doc. Click the Build Target

button ¥ in Doc-To-Help. After the build is complete, view the Target. See Building and Examining a Target on page
18 for more information.

The project will open in your browser.

(2 All About Pittsburgh | |
File Edit

View Favorites

Tools  Help

= Pittsburgh G o8 |=|y |

All About Pittsburgh All About Pittsburgh

Pittsburgh Sports Pittsburgh is a great place to live, work, and visit. "All About Pittsburgh” is a
resource that will help you learn more about Pittsburgh’s history,
neighborhoods, sports teams, colleges and universities, popular attractions, and
more.

Pittsburgh Sites

m

Pittsburgh is the second-largest city in Pennsylvania and was once known as
"The Steel City.” However, manufacturing is no longer at the heart of
Pittsburgh’s economy. Pittsburgh is now a high-tech center, and is now focused
on the health care, education, technology, and financial services industries.
Pittsburgh is also known for its successful and popular sports teams.

The city of Pittsburgh, Pennsylvania recently celebrated its 250th anniversary. ]
The center of Pittsburgh is the often-photographed confluence — the spot where
the Monongahela and Allegheny rivers meet to form the Qhio.

*

Favorites
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Click on "Pittsburgh's 250th Anniversary" in the table of contents. You'll see that:
e "250th Anniversary" is a hyperlink that will display text (Its semiquincentennial!) when clicked.

e "Monongahela™ is not highlighted in the Target (but it is included in the Index — click the Index button above
the Table of Contents).

e The first two bullet points (about the South Side and Station Square) are properly formatted.
o "Pittsburgh Pirates is a hyperlink that opens the "Baseball" topic.

You will also notice that the project name appears in the header as ""Pittsburgh — the name we gave the .D2H project
in the wizard. We will change that in the next step using the Help Targets dialog box.

Defining Help Targets

By default, our sample has nine default Help Targets. Using the Help Targets dialog box in Doc-To-Help, we can
rename our targets and delete the ones we don't need.

First, click the Target ribbon group dialog box launcher to open the Help Targets dialog box.

ﬁ Home Topics
3] 3 @ éd 4% publish ~
i?/ @ ) ) Cancel Build

Project

QJTargatTemplate' 'j MNew * [ Platforms

- B 2
"E:J Source Template ™ =| aﬁ % ]

[ %] = b T4 =
Select | Build Rebuild View A TR L4 Add & : %] Source CS5 ~ Share Synchronize Translate Wor
Target - - - (:f Build Log ETheme - :_j Remove [t ] Attributes T Off
Target - NetHelp Target Design Source SharePoint® Documents
r
Documents ' Help Targets Ié]
ERERGEFTCIER
Lk
Add Mew Target ~ X Remove Target ‘y
4] PittsburghQuickTour.doc @ - 2 < SilEsE
o Eclipse Help Mame: MetHelp
EPUB =
_b Help 2.0 Base name: T
LS HTML Help
. JavaHelp Style sheet: [NatHeIp.(.ss 'l
Manual Template [czHHTMLDOT -
§ M5 Help Viewer
Theme: [Responslve - I
L& WinHelp
NetHelp 2.0 Target
Attributes: (none) -
Folder: NetHelp E]
=l Localization
1033 - English (United States)
65001 - Unicode (UTF-8)
utf-8
-_j Documents =l Background
L] Contents l:l i
ﬂ Index and Groups
© Hel i QK I [ Cancel ]
8] Related Topics E=s

Since NetHelp is our default Target, that is the option displayed first. Let's change the Name field from "NetHelp" to
"All About Pittsburgh NetHelp."

As soon as you click in the window on the left, the name of the project will change in that list.
Also enter "All About Pittsburgh™ in the Caption field. This will change the name displayed in the browser from
"Pittsburgh" to the name we prefer.
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. Help Targets Lﬁ

(@) Add Mew Target - X Remove Target O Basic -
----- = Eclipse Help Name: All About Pittsburgh NetHelp
..... & EPUB
..... _b Help 2.0 Base name:
..... 5§ HTML Help 5
_____ & JavaHelp Style sheet: ’NetHeIp.css 'l =
| Manual Template: [cH_HTMLDOT -
----- M3 Help Viewer
é All About Pittsburgh NetHelp | Theme: [Re;pon;ive v]
WinHelp .

NetHelp 2.0 Target

Attributes: {none) -

Folder: NetHelp E

s \_,“__..,.‘ﬂ*.h_“’p..n-a..__ .W. *M—-—A-ﬂ\-ﬂﬁ‘&.‘ e s, o SR ol e, | )

B T . - - [ - == e, =
e R R oy S P e S e - —— e ot *‘-"—-—-—-—-——.H—_‘v‘___

= Advanced
Caption: All About Pittsburgh | E

? QK l l Cancel l

h

Click on the HTML Help (compiled HTML Help) Target on the left. Rename it also.

Do the same with the Manual Target. While you are there, scroll down and change the "Title" to "All About
Pittsburgh,” the "SuperTitle" to "Visitors Guide,” and the "By Line" to "Pittsburgh Productions."

Since we don't need to create Help 2.0, JavaHelp, MS Help Viewer, Eclipse Help, or WinHelp for this project, click on
those Targets in the window on the left and click the Remove Target button for each. (You can always add them back

later.) Click OK.

Now, click the Select Target button. The newly named Targets are displayed, instead of the defaults.

E Home Topics Project
!E @ % éd %€ Publish

Select || Build Rebuild View © Cancel |
- - <7 Build Lo

| € All About Pittsburgh EPUB

j) All About Pittsburgh HTML Help
2| Al About Pittsburgh Manual
€ Al About Pittsburgh MetHelp

If you'd like, save and close your documents. Select each Target, then build and view the Targets. You will see the
changes we made displayed in each Target.

Please note: you can have several versions of the same Target. For example, you could have multiple NetHelp Targets
directed at different audiences. Just add them using the Add New Target button in the Help Targets dialog box.
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Creating Custom Topic Relations

As we discussed earlier, when you open your NetHelp Target and click on the "Pittsburgh Sports" topic in the Table of
Contents, you will notice that at the bottom of the topic, there is a section that begins with "More:," followed by links to
"Football," "Baseball," and "Hockey." These are called Subtopic Links and they are created automatically by Doc-To-
Help, based on the structure of your document.

Pittsburgh Sports

Pittsburgh is well-known for its professional sports teams, and has been hailed as
the "City of Champions"” because two teams (the Pittsburgh Steelers and
Pittsburgh Pirates) won their league’s world championships in the same year
{1979). The Pittsburgh Penguins have also won the Stanley Cup three times
(1991, 1992, and 2009).

More:
Football

Baseball
Hockey

"Pittsburgh Sports" is a Heading 1, and "Football," "Baseball," and "Hockey" are Heading 2's immediately following it
in PittsburghQuickTour.doc. If there were Heading 3's under "Football" they would appear as Subtopic Links in that
topic.

By default, the word "More" appears before the Subtopic links, but you can change that. Open the Help Targets dialog
box for your Help Target and change it in the Label field.

You can change it for individual topics by selecting a Topic in the Topics window and changing the Related Links
Label in the Topics ribbon.

ﬁ Home Topics Project

@ J? l#|;_ @ {% Lj" Platforms: ~ | | Related Links Label;
Print and Filter | Contents Index Related @Targets: v e
Export~ View - Topics 1| Attributes: » | | Hide subtopic links
View Condition Related Topics

It is easy to add your own custom topic relations using the Related Topics pane.

Open the Related Topics pane and choose Pittsburgh Sports from the list. You'll see that "Football" "Baseball" and
"Hockey" are displayed in the pane below automatically. Select Pittsburgh Sites from the Topics window and drag it
into the lower Related Topics pane. It is now related (it is marked as a Custom related topic).
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Iiﬂ Home Topics Project
@ &% Iﬁplatforms: ™ Related Links Label: :;
|

Print and Filter | Contents Index Related %Targets: T | [More Propertis
Export~ View -~ Topics Attributes: = | [C] Hide subtopic links
View | Cendition | Related Topics | Propertis
Related Topics 4% startPage V2 output V[5] Topics x Lﬂ
ERE] [Ei 7 | & Document Title
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IEI@ Pittsburgh Sports Documents'Pitts...  All About Pittsburgh
g::z::: Documents\Pitts...  Pittsburgh Sports
i Hockey Documents\Pitts...  Football
= Pittsburgh Sites Documents'Pitts...  Baseball
Documents\Pitts...  Hockey

I DocumentshPitts... éPittsburgh Sites

“ 4 Related Topics

=4 Custom related topics

-5 Subtopics
i.|z| Football (PittsburghQuickTour.doc)
g

4| 0 | *

ED Documents

.j_:" Contents

@ Index and Groups
Related Topics

Save and close your documents, then click the Rebuild Target button and build your project.

Home Topics Project
¢ &8

Select | Build IRebuild| View @ Cancel Build
Target- - - <7 Build Log
Target - All About Pittsburgh NetHelp M |

Getting Started Workbook Doc-To-Help Quick Tour e 33



Look at the new list of subtopic links for Pittsburgh Sports. “Pittsburgh Sites” has been added to the list.

Pittsburgh Sports

Pittsburgh is well-known for its professional sports teams, and has been hailed as
the "City of Champions" because two teams (the Pittsburgh Steelers and
Pittsburgh Pirates) won their league’s world championships in the same year
{1979). The Pittsburgh Penguins have also won the Stanley Cup three times

(1991, 1992, and 2009).

More:

£) rittsburgh Sites
£) Foatball

£) Baseball

€) Hockey

If you would prefer the subtopic links are not displayed in a specific topic, choose that topic in the Topics window and
select the Hide Subtopic Links check box from the Topics tab.

Iaﬂ Home Topics Project
& ::{J Platforms: | Related Links Label: - ﬁqu,

Print and Filter | Contents Index Related @Targets: . More: Properties | Open
Export~ View~ Topics ] Attributes: v E Hide subtopic links I
View Condition Related Topics Properties | Editor

As you can see, automatic and custom topic relations give you a lot of options for navigating your Help project.

For example:

e You can create custom links to other topics that users may find useful — and the links are very clear and
noticeable.

e You can create custom links from subtopics to their "parent™ topics — this directs the user back to the parent,
which may lead them to other topics of interest.

e Relating topics eliminates information "deadends" — the user has links to other information and could be saved
the trouble of using search, or checking the TOC or index.
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Adding a Document

On occasion, you might need to add an existing document to your project after you've created it, so let’s do that now.
We'll take this opportunity to add a Glossary to our project.

Click the Add Existing Documents button in the Documents pane.

DehE g 9-0-|s

E Home Topics Project

'E géj %} @d 3 publish - &
Build | £
Select | Build Rebuild View - | =
Target - = = (\;7 Build Leg =1
Target - All About Pittsburgh MetHelp P
Documents

'ﬂj '“*_ll@ﬂx - ¥ §
----- @ PittsburghQuickTour.doc

The Document Import Wizard will open. Follow the same steps we used when importing PittsburghQuickTour.doc,
but this time, choose Glossary.doc from the \My Doc-To-Help Projects\Samples\All About Pittsburgh
Word\Documents folder.

We could have imported this originally, but now you can see how easy it is to do after you have already created your
project ...
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After the import is complete, the new document will appear in the Documents pane.

Documents
E" L_:I ﬂ'D@ﬂx e
----- @ PittsburghQuickTour.doc

8

Eh Documents

.j_:" Contents

@ Index and Groups
Related Topics

Since a Glossary is a special type of document in Doc-To-Help, right-click on it and choose Glossary from the menu.
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Documents /44 start Page
o P =X e v ¢ %
48] PittsburghQuickTour.doc Reading project d
@ Glossary.dige

|E Open with Microsoft Word

@ Convert to HTMLS...

4. Expand All

2. Collapse All

ﬂ Create Mew Document 3

_3, Add Existing Documents

@ Convert Multiple Documents to HTMLS...

= Rename Document

¥  Remove Document

=% CopyLink

|m'& Glossary |

— I,

“f  Properties... be

%1 Share Document to SharePoint Library

Our document is now flagged as a Glossary with a special icon.

Documents
'ﬂ :J s '_;'@ﬂx 4 @

¥ PittsburghQuickTour.dec
Glossary.doc

Double-click on Glossary.doc to open it. You'll see that two index entries are in this document: Confluence and
Primanti Brothers Sandwich. If you put your cursor in either heading, you'll notice that they are formatted with the
Glossary Heading style. This style has a special behavior in online Help Targets.

*

Close Glossary.doc and build your Target. You'll notice that Glossary has been added to the Table of Contents, plus the
word "confluence" is now a hyperlink. When you click on it, the glossary entry is displayed as a popup.
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= All About Pittsburgh o 8= v f @
All About Pittsburgh All About Pittsburgh
Pittsburgh Sports Pittsburgh is a great place to live, work, and visit. All About Pittsburgh” is a

resource that will help you learn more about Pittsburgh's history,
neighborhoods, sports teams, colleges and universities, popular attractions, and

Pittsburgh Sites

more.

m

Pittsburgh is the second-largest city in Pennsylvania and was once known as
"The Steel City.” However, manufacturing is no longer at the heart of
Pittsburgh’s economy. Pittsburgh is now a high-tech center, and is now focused
on the health care, education, technology, and financial services industries.
Pittsburgh is also known for its successful and popular sports teams.

Glossary

The city of Pittsburgh, Pennsylvania recently celebrated its 250th anniversary. 4

The center of Pittsburgh is the often-photographed tonfﬁuenﬁg": — the spot where
the Monongahela and Allegheny rivers r
Confluence

-' The flowing together of two or more streams to form a

This popup is a Doc-To-Help feature — Doc-To-Help automatically creates links from topic text to identical glossary
entries — but only once in each topic. This can be turned off if you like, but it is a great way to give your readers access to
useful definitions that they might normally miss, with no extra work on your part. If you would like to create a manual
link to a glossary entry, simply create a link using the Glossary Link Type in the Link dialog box.

Note: To add a new, empty document to your project, click the Add New Document button in the Documents pane
toolbar.

Documents
'J'd:'l ﬂ'_;'@ﬂx - W F 5
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Adding Glossary Entries

It is easy to add additional entries to your glossary — and you don't need to worry about alphabetizing them because
Doc-To-Help will do it for you.

Open Glossary.doc. It contains two entries.

Glossary

Confluence

The flowing together of two or more streams to form a third.

Primanti Brothers Sandwich

A sandwich inventedin Pittsburgh by the Primanti Brothers. It includes fries and cole slawnght on the sandwich. See
http:‘prmantibrothers com’ for pictures and detaﬂs.l

It's easy to add more entries and alphabetize the list.
After the first two entries, add the following:

Ohio River
A river that begins in Pittsburgh and joins the mighty Mississippi in Illinois.

Now, we need to apply styles to the new entry. These styles not only control the look of the entries, but also the
behavior.

Click on Confluence, you'll notice the style is Glossary Heading. The definition is C1H Popup Topic Text. Apply
those styles to Ohio River and its definition. (Use the same method we used when we applied the C1H Bullet style

earlier.)
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It will look like this:

Glossary

Confluence

The flowing together oftwo or more streams to form a third.

Primanti Brothers Sandwich

A sandwich inventedin Pittsburgh by the Primanti Brothers. It includes fries and cole slaw right on the sandwich. See
http:/‘primantibrothers.com’ for pictures and details.

Ohio River
Anver thatbegins in Pittsburgh andjoins the mighty Mississippi in linecis.

Ohio River is in the Glossary, but now the Glossary is not in alphabetical order. To fix that, click the Sort button in the
Doc-To-Help ribbon. The Glossary will now be alphabetized.

i Doc-To-Help g
= == i @ ] 4
{ _Jg rr @ Flash Maovie '.:.BC %
= 4 5 HTML Help Control
}Margin Image - Add Sort
Mote -~ Map Editor ‘] Cross-reference = Terms
Links Glossary

Save and close Glossary.doc. Build the project.

"Ohio River" is now in the list of topics in the Topics window.
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Document
o
i) Documents\Pitts...
@ Documentsh\Pitts...
@ Documents'\Pitts...
i¥] Documents\Pitts...
i) Documents\Pitts...
i#] Documents\Pitts...
Documents\Glos...

Documents'Glos..,

Documents'Glos..,

Documents\Glos...

HAHTETE

Title

All About Pittsburgh
Pittsburgh Sports
Football

Baseball

Hockey

Pittsburgh Sites
Glossary

Confluence

 Ohio River

Primanti Brothers Sandwi...

Style

Heading 1
Heading 1
Heading 2
Heading 2
Heading 2
Heading 1
Heading 1
Glossary Heading
Glossary Heading
Glossary Heading

Creating a Customized Table of Contents

As you've already seen, Doc-To-Help automatically creates a Table of Contents for you based on the structure of your
documents. But you can customize your Table of Contents if you wish.

Open the Contents pane. If you select an item in the Table of Contents and click Remove Topic to remove it — or drag
a topic from the Topics window into the Contents pane to add it — the table of contents will be flagged as
Customized. Changing the name of an item in the TOC (using the Rename button) will also customize it.

Contents

I_uslumzed

.tl.:l Y

------ ~Al) Al About Pittsburgh
E| @ Pittsburgh Sports

oEmE

% Gy &

vlx @

If you would like this table of contents to be exclusively used for the Target selected, click the Target-Specific Table of

Contents button.

Contents

Customized

44 e » e
I All Abeut Pittsburgh

=1 X |@)

If you decide that you would prefer to return to the original table of contents (based on the document structure) click the
Rebuild Table of Contents button.

Contents

Customized

EREIPN v [B]«

...... ) All About Pittsburgh

v = X @
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Adding Items to the Index and Creating Groups

There is already one item in our index, which we added directly from one of our documents. We can also add items using
the Index and Groups pane, along with the Topics window.

Click on the Index and Groups pane, and click the Keyword button.

LS

' ™
DEEI9-0-|5 ComponentOne Doc-To-Help - Pittsburgh.d2h | = | El ﬂ
A8 Home Topics Project b @
? l_#;_ ﬁplatforms: T Related Links Label: ;‘ ."ﬁ’"
6d = i =7
Print and Filter | Contents Index Related Targets: i o Properties | Open
Export~ View - Topics Attributes: - | [0 Hide subtopic links
View Condition | Related Topics | Proper‘ties| Edit0r|
KEYWDI'dS @ Start Page /Vé Output Topics X
= L+J L—J ‘%_? .%3 =l X Document |Trtle Style Keywords Context 1D
¥ Monongahela w
@ Documents\Pitts...  All About Pittsburgh Heading 1 Monongahela
9 9 9
@ Documents\Pitts...  Pittsburgh Sports Heading 1
gh ap 9
Documents\Pitts...  Football Heading 2
' Monongahela: One Topic Indexed Docurnents\Pitts...  Baseball Heading 2
------ i All About Pittsburgh (PittsburghQuickTour.dol Documents\Pitts... Hockey Heading 2
Documents\Pitts...  Pittsburgh Sites Heading 1
A'E Documents\Glos...  Glossary Heading 1
AE Documents\Glos...  Confluence Glossary Heading
4 1 3
| A'E Docurnents\Glos...  Ohio River Glossary Heading
|ID Documents AE Docurnents\Glos...  Primanti Brothers Sandwi... Glossary Heading
j_:" Contents
@ Index and Groups
al] _
Related Topics < [ s
Ready |z
4

Click the Add New Keyword button.

Keywords

BN Kepora

! Monongahela
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Name the keyword "sightseeing." Then select the topic "Pittsburgh Sites" from the Topics window and drag it into the
lower Keywords pane. You can link multiple topics to a single keyword; just drag them into the lower pane also.

i ™y
O BaEg 9-0- < ComponentOne Doc-To-Help - Pittsburgh.d2h | = | 5] ﬂ

liﬂ Home Topics Project wp '@
@ &% 7 Platferms: T | Related Links Label: - Y:,»
& =,

Print and Filter l Contents Index Related Targets: T | [Mor= Properties  Open
Export - View - Topics Attributes: = | [0 Hide subtopic links
View Condition [ Related Topics | Properties | Editor

K'BYWDI'dS /ﬁ} Start Page
HEEEEEEE e
f'ﬁ sightseeing g
T Monongahela Documents\Pitts...  All About Pittsburgh Heading 1
DocumentsiPitts...  Pittsburgh Sports Heading 1
DocumentsiPitts..  Football Heading 2
sightseeing: 0 Topics Indexed DocumentsiPitts...  Baseball Heading 2
Pittsburgh Sites (PittsburghQui DocumentsiPitts., Hockey Heading 2
@ DocumentshPitts... éPittsburgh Sites I Heading 1
A’EZ DocumentsiGlos.,  Glossary Heading 1
A’EZ DocumentsiGles..  Confluence Glossary Heading
A’EZ DocumentsiGlos..  Ohio River Glossary Heading
ED Documents A’EZ DocumentsiGlos..  Primanti Brothers Sandwi.. Glossary Heading

j_jl Contents

@ Index and Groups
Related Topics

You can create topic Groups using this same pane. Topic groups are collections of topics you can create links to. When
the user clicks the link, the topics in the group will display in a popup window or dialog box.

First, click the Groups button in the Index and Groups pane.

Groups

QE e

|Ih Documents

ZE| contents

Jﬁ Index and Groups
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Click the Add Group button and name the new group "Sports."

Select the topics "Football”, "Baseball”, and "Hockey" in the Topics window and drag them into the lower Groups

pane.

Groups 73} Start Page /VE Output/’ﬂ Topics X

7 [Eﬁ = X Document Title Style

--[5 Sports '
@ Documents\Pitts...  All About Pittsburgh Heading 1
@ Documentsi\Pitts...  Pittsburgh Sports Heading 1
@ Documents\Pitts...  Football Heading 2

Sports: 3 Tepics Indexed @ Documents\Pitts...  Baseball Heading 2

;;,5 Baseball (PittsburghQuickTour.doc) @ Document=iPitts... EHockey Heading 2

i ;2 Football (PittsburghQuickTour.doc) :

;:; Hockey (PittsburghQuickTour.doc) & Docurnents\Pitts...  Pittshurgh Sites Heading 1
AE,E Documents\Glos...  Glossary Heading 1
Ai& DocumentsiGlos...  Confluence Glossary Heading
AE,E Documents\Glos...  Ohio River Glossary Heading
=

__h:] Documents

L] Contents

ﬂ Index and Groups

55 Related Topics

DocumentsiGlos...

Primanti Brothers Sandwi... Glessary Heading

These topics are now a group named "Sports™ and you can create a link to them using the Link dialog box.

Open PittsburghQuickTour.doc and in the "Pittsburgh Sports" topic, select the word "sports."”

Click the Link button on the Doc-To-Help ribbon tab and choose Group from the Link type drop-down. Select the

Sports check box and click OK.
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Pittsburgh Sportsq]

Pittsburgh is well-known forits pmfes.sinnae ams, and hasbeen hailed asthe “City of Champions™ because two
teams (the Steelers and Pirates) won their league’s world championships n the same year(1979). The Pittsburgh
Penguns have & ] i

_ Link ==
] F'U'Utba Teut: sports

The six time 81| |Link type: [{Z Group ~ =
The Steelers wq Target fle
Lo
team. Group: Sports
Steeler fans — § le
Towel, thelate Groups
Leammoreabd | [ 4[5 Sports
- Link options
Baseba
Topic list in: (Default) -
MajorLeague B Park,
located onthe b Window: (Default) -
Leammore abg

Options

- | Hide properties in document
Hockey

Show as button

The Pittsburgh they
defeatedthe De IS
the NHL, Sidne @ Help OK l | Cancel

Mano Lermeux
Mellon Arena, t - — = T T

Leammore about the Penguins at http//werw. pittsburshp ensuins com/

Save and close your document. Build your Target.
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Now, "sports” is a hyperlink, and when you click on it, a menu with all of the topics in that group displays. Select any
one of the menu items, and the topic opens.

| 2 Pittsburgh Sports | |

File Edit View Favorites Tools Help

Pittsburgh Sports

All About Pittsburgh oo 8= v fl ©

Pittsburgh Sports

Football Pittsburgh is well-known for its professional sports teams, and has been hailed as
the “City of Champions” because two teams Ba_#Aball >urgh Steelers and
Pittsburgh Pirates) won their league’s world  Football ships in the same year
(1979). The Pittsburgh Penguins have also Hockey :anley Cup three times
{1991, 1992, and 2009).

Baseball

Hockey
More:

Pittsburgh Sites
Football
Baseball

Hockey

We hope you enjoyed the Doc-To-Help Quick Tour! Feel free to use this project to test-drive Doc-To-Help further.

Additional Resources

The schedule of free Doc-To-Help introductory webcasts can be found at: http://www.doctohelp.com/Pages/\Webcasts/.

Information about training classes and self-paced training manuals is available here:
http://www.doctohelp.com/Products/DocToHelp/TrainingConsulting/.

Sample Doc-To-Help projects can be found in the following location. These projects demonstrate Doc-To-Help features
and functionality. There are sample projects that feature each type of document editor, software documentation, API
reference documentation, an employee policy manual, and more.

e Windows® 7/8 and Vista: \\Users\<username>\Documents\My Doc-To-Help Projects\Samples

e Windows XP: \\Documents and Settings\<username>\My Documents\My Doc-To-Help Projects\Samples

Also see the PDF quick reference guides available on the Start Page of Doc-To-Help, and the Help menu (available
from the File tab.)
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